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[bookmark: _Toc75938720][bookmark: _Toc396387019][bookmark: _Toc534108046][bookmark: _Toc513360261][bookmark: _Ref513177801][bookmark: _Ref508254386][bookmark: _Toc502848047][bookmark: _Hlk101193097][bookmark: _Toc125363629]zzzPAT-ohjelmiston esittely
Huomautus: Tässä asiakirjassa nimi WatchPAT viittaa 4 laitteeseen (WP200, WP200U, WatchPAT™ 300 ja WatchPAT™ ONE), ellei toisin ole mainittu.

Tarkemmat ohjeet kuvineen löytyvät Itamar-Medicalin verkkosivustolta ( https://www.itamar-medical.com/support/downloads/  )

[bookmark: _Toc500760470][bookmark: _Toc75938721][bookmark: _Toc396387020][bookmark: _Toc203489306][bookmark: _Toc502848050][bookmark: _Toc502848048][bookmark: _Toc513360263][bookmark: _Toc534108048][bookmark: _Toc5874853][bookmark: _Toc9050222][bookmark: _Toc125363630]Watch-PAT200-laitteen käyttötarkoitus/käyttöaiheet
Watch-PAT200 (WP200) on ei-invasiivinen kotihoitolaite, jota käytetään potilaille, joilla epäillään olevan unen aikaisia hengityshäiriöitä. Laitetta voidaan käyttää apuna unen aikaisten hengityshäiriöiden havaitsemisessa ja diagnosoinnissa sekä eri univaiheiden (REM-uni, kevyt uni ja syvä uni) tunnistamisessa. Laite laskee perifeerisen arteriaalisen tonometrian (PAT), hengityshäiriöindeksin (pRDI), apnea-hypopneaindeksin (PAHI) ja univaiheiden PAT-tunnistuksen (PSTAGES) sekä valinnaisesti kuorsauksen tason ja vartalon asennon ulkoisen integroidun kuorsausta ja vartalon asentoa mittaavan anturin (SBP) avulla. Laite saa toiminnoista PSTAGES ja SBP lisätietoa PRDI-/PAHI-määrityksiin. Laitteen toimintoja PSTAGES ja SBP ei ole tarkoitettu käytettäväksi ainoana tai pääasiallisena perusteena unen aikaisten hengityshäiriöiden diagnosoinnissa, hoitomääräyksissä tai sen määrittämisessä, onko muu diagnostinen arviointi perusteltua.

WP200-laitetta ei ole tarkoitettu käytettäväksi alle 17-vuotiaille lapsille.
[bookmark: _Toc75938722][bookmark: _Toc125363631]Käyttötarkoitus ja -aiheet laitteille Watch-PAT200U, WatchPAT™ 300 ja WatchPAT™ ONE
Watch-PAT200U (WP200U) , WatchPAT™ 300 ja WatchPAT™ ONE -laitteet ovat ei-invasiivisia kotihoitolaitteita, jotka on tarkoitettu käytettäviksi sellaisten potilaiden kanssa, joilla epäillään olevan unenaikaisia hengityshäiriöitä. WP200U, WatchPAT™ 300 ja WatchPAT™ ONE toimivat diagnostisena apuna unenaikaisten hengityshäiriöiden, unen eri vaiheiden (vilkeuni (REM-uni), kevyt uni, syvä uni ja hereillä), kuorsaustason ja kehon asennon havaitsemisessa. Laite laskee perifeerisen arteriaalisen tonometrian (PAT), hengityshäiriöindeksin (pRDI), apnea-hypopneaindeksin (PAHI), apnea-hypopnean keski-indeksin (PAHIc) ja univaiheiden PAT-tunnistuksen (PSTAGES) sekä valinnaisesti kuorsauksen tason ja vartalon asennon ulkoisen integroidun kuorsaus- ja vartalon asentoanturin avulla. Laite saa toiminnoista PSTAGES, kuorsauksen taso ja vartalon asento lisätietoa PRDI-/PAHI-/PAHIc-määrityksiin. Laitteen toimintoja PSTAGES, kuorsauksen taso ja vartalon asento ei ole tarkoitettu käytettäväksi ainoana tai pääasiallisena perusteena unen aikaisten hengityshäiriöiden diagnosoinnissa, hoitomääräyksissä tai sen määrittämisessä, onko muu diagnostinen arviointi perusteltua.

PAHIc on tarkoitettu käytettäväksi vähintään 17-vuotiaille potilaille. Kaikkia muita toimintoja voidaan käyttää vähintään 12-vuotiaille potilaille.

Huomautus: pAHIc-arvo käy ilmi raportista, mikäli sääntelyviranomaiset ovat sen kyseisessä maassa hyväksyneet
[bookmark: _Toc75938724][bookmark: _Toc396387021][bookmark: _Toc203489307][bookmark: _Toc125363632]zzzPAT-ohjelmiston määritelmä 
zzzPAT on WP-laitteiden kanssa käytettävä analyysiohjelmistopakkaus, joka tukee unen aikaisten hengityshäiriöiden diagnosoinnissa, havaitsee unen eri vaiheet (REM, kevyt uni, syvä uni ja hereillä olo) sekä mittaa kuorsauksen voimakkuuden ja vartalon asennon. zzzPAT-ohjelmisto näyttää WP-laitteiden tallentamat signaalit, tunnistaa hengityshäiriötapahtumat, unen eri vaiheet sekä kuorsauksen ja vartalon asentotiedot. Lisäksi se luo kattavan raportin lääkäriä varten.
[bookmark: _Toc75938725][bookmark: _Toc396387022][bookmark: _Toc203489308][bookmark: _Toc125363633]Yleiskuvaus

zzzPAT-algoritmit käyttävät neljää WP-kanavaa: PAT, pulssi, aktigrafia ja happisaturaatio (joko tallennettu WP200-laitteella tai saatu WP200U-/ WatchPAT™ 300-/ WatchPAT™ ONE -laitteesta) unenaikaisten hengityshäiriöiden ja unen eri vaiheiden (vilkeuni (REM-uni), kevyt uni, syvä uni ja hereillä) havaitsemiseksi. WP200U-, WatchPAT™ 300- ja WatchPAT™ ONE-laitteissa sentraalisen uniapnean tunnistamista helpottaa, että RESBP-anturin muiden WP-kanavien lisäksi käytetään hengitysliikkeiden kanavaa. 
zzzPAT käyttää WP-laitteen kuorsaus- ja asentokanavia kuorsauksen tason ja vartalon asennon tilojen määritykseen. Ohjelmisto tuottaa tutkimuksen pohjalta kattavia raportteja, joihin sisältyy tilastoja ja tulosten graafinen esitys. Koko yön aikaiset tiedot ovat näytettävissä, ja automaattisesti havaitut tapahtumat ovat tarkasteltavissa manuaalisesti.

Huomautus: Tässä asiakirjassa kuorsausta ja vartalon asentoa mittaavalla anturilla viitataan sekä SBP-anturiin että RESBP-anturiin, ellei toisin ole mainittu. WP200(U)-/ WatchPAT™ 300-laitteessa kuorsausta ja vartalon asentoa mittaavan anturin käyttö on vapaaehtoista ja tapahtuu lääkärin suositusten mukaisesti. RESBP-anturia voi käyttää, mikäli sääntelyviranomaiset ovat sen kyseisessä maassa hyväksyneet.

Käyttöoppaassa on tarvittavat tiedot zzzPAT-ohjelmiston rutiinikäyttöön.

Rajoitukset
WP-järjestelmien tarjoamat havainnot ja laskelmat on tarkoitettu apuvälineiksi unen aikaisten hengityshäiriöiden diagnostiikassa. Niitä ei nimenomaisesti ole tarkoitettu ainoaksi ehdottomaksi perustaksi kliiniselle diagnoosille.
zzzPAT-ohjelmistoa saa käyttää vain yhteensopivissa tietokoneissa, jotka täyttävät tässä asiakirjassa määritetyt vaatimukset.
Muiden ohjelmien, joko kaupallisesti saatavana olevien tai mukautettujen, suorittaminen samanaikaisesti zzzPAT-ohjelmiston kanssa saattaa häiritä sen toimintaa.
Uni- ja lepotilaominaisuudet on poistettava käytöstä, jos käytössä on jaettu tietokanta.


[bookmark: _Toc75938726][bookmark: _Toc396387023][bookmark: _Toc125363634]Asentaminen
[bookmark: _Toc75938727][bookmark: _Toc396387024][bookmark: _Toc534108050][bookmark: _Toc513360265][bookmark: _Toc125363635]zzzPAT-ohjelmiston yleiskuvaus
zzzPAT on patentoitu tietokoneohjelmisto, joka on kehitetty nimenomaisesti WP-laitteen tallentamien tietojen hallintaan ja analysointiin. Ohjelmisto esittää ja tallentaa kerätyt signaalit, ja sen analyysitoiminnoilla voi tulkita tietoja.

WP200(U)-/ WatchPAT™ 300-laitteessa WP-laitteen sisäiseen muistikorttiin tallentamat tiedot luetaan USB-kaapelin avulla. zzzPAT-ohjelmisto tunnistaa automaattisesti sisäisessä muistikortissa olevat tiedot, kun WP yhdistetään tietokoneeseen USB-tiedonsiirtokaapelilla.
WatchPAT™ ONE -laitteessa käytetään Internet-yhteyttä WatchPAT™ ONE -laitteella tallennettujen tietojen lukemiseksi. zzzPAT-ohjelmisto avaa automaattisesti luettelon kaikista rekisteröidyistä potilaista, joiden tutkimusta ei vielä ole haettu verkkopalvelimelta.
Lisätietoja tarvittavasta tietokonekokoonpanosta on kohdassa 0.

zzzPAT-ohjelmistoa voi käyttää kahdessa tilassa:

Erilliskäyttö – käytetään yksittäisessä tietokoneessa paikallisen tietokannan kanssa.
Jaettu käyttö – käytetään verkkoympäristössä, jossa useista zzzPAT-työasemista on yhteys yhteen, jaettuun tietokantaan. 
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	Huomautus

	
	On erittäin suositeltavaa koordinoida zzzPAT-ohjelmiston jaetun käyttötilan määrittäminen Itamar Medical -edustajan kanssa. Asianmukainen käyttö edellyttää lisäkoulutusta.
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	Varoitus

	
	WatchPAT200U on tietokonekäyttöinen laite. Suosittelemme, että harjoitat riittävää ja asianmukaista käyttöoikeuksien valvontaa ja että suojaat järjestelmäsi ja tiedostosi virustorjuntaohjelmistolla.



[bookmark: _Toc534108124][bookmark: _Ref30906401][bookmark: _Toc396387025][bookmark: _Toc513360266][bookmark: _Toc534108051]zzzPAT-käyttötila määritetään asennuksen aikana, kuten kattavan kuvitetun oppaan asennusta käsittelevässä kohdassa kerrotaan.
[bookmark: _Toc448932632][bookmark: _Toc448932636][bookmark: _Toc448932639][bookmark: _Toc448932640][bookmark: _Toc448932642][bookmark: _Toc396386972][bookmark: _Toc396387028][bookmark: _Toc396386973][bookmark: _Toc396387029][bookmark: _Toc448932647][bookmark: _Toc448932648][bookmark: _Toc448932649][bookmark: _Using_zzzPAT_Software][bookmark: _Toc502848056][bookmark: _Ref508259397][bookmark: _Ref508259407][bookmark: _Ref508536776][bookmark: _Ref508536782][bookmark: _Toc513360268]
[bookmark: _Ref530980953][bookmark: _Toc534108054]
[bookmark: _Toc75938728][bookmark: _Toc396387035][bookmark: _Ref29868162][bookmark: _Toc125363636]zzzPAT-kokoonpanon määrittäminen
[bookmark: _Toc448932658][bookmark: _Toc448932657][bookmark: _Toc448932656][bookmark: _Toc448932655][bookmark: _Toc75938729][bookmark: _Toc396387037][bookmark: _Toc534108100][bookmark: _Toc513360303][bookmark: _Toc125363637]Asetukset>Hakemistot
Tuo esiin zzzPAT-työhakemiston, tällä hetkellä yhdistettynä olevan tietokannan nimen, tiedostohakemiston (signaalitiedostojen tiedot) ja USB-aseman. 

Näet jaettuun tietokantaan yhteydessä olevat käyttäjät valitsemalla DB Logged Users (Tietokantaan kirjautuneet käyttäjät). 
Luettelossa ovat kaikkien niiden tietokoneiden nimet, jotka käyttävät samaa jaettua tietokantaa ja joissa zzzPAT-sovellus on käynnissä.
[bookmark: _Toc75938730][bookmark: _Toc396387038][bookmark: _Toc534108101][bookmark: _Toc513360300][bookmark: _Toc502848061][bookmark: _Toc125363638]Asetukset>Käyttäjäasetukset  
Käyttäjä voi muuttaa seuraavia määritysparametreja avaamalla User Settings (Käyttäjäasetukset) -valintaikkunan kohdassa Setup>User Settings (Asetukset>Käyttäjäasetukset). Jokaisen käyttäjän User Settings (Käyttäjäasetukset) -määritysparametrit tallentuvat zzzPAT-tietokantaan (erillisasennuksessa paikalliseen tietokantaan ja jaetussa asennuksessa jaettuun tietokantaan).

	[image: clip_image002]
	Huomautus

	
	Kun jaetussa käyttötilassa käyttäjiä kirjautuu sisään useista zzzPAT-työasemista samanaikaisesti, kaikki zzzPAT-ohjelmiston käyttäjäasetusten muutokset eivät välttämättä tallennu zzzPAT-istunnon päätyttyä.




[bookmark: _Toc534108102][bookmark: _Toc513360302]Kun kaikki muutokset asetuksiin on tehty, sulje Settings (Asetukset) -valintaikkuna valitsemalla OK.

Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _Toc23069019][bookmark: _Toc23069018][bookmark: _Toc23069017][bookmark: _Toc23069016][bookmark: _Toc23069015][bookmark: _Toc23069014][bookmark: _Toc23069013][bookmark: _Toc23069012][bookmark: _Toc23069011][bookmark: _Toc23069010][bookmark: _Toc23069009][bookmark: _Toc23069008][bookmark: _Toc23069007][bookmark: _Toc23069006][bookmark: _Toc23069005][bookmark: _Toc23069004][bookmark: _Toc23069003][bookmark: _Toc23069002][bookmark: _Toc23069001][bookmark: _Toc23069000][bookmark: _Setup>User_Settings>Options][bookmark: _Toc23068999][bookmark: _Toc23068998][bookmark: _Toc23068997][bookmark: _Toc23068996][bookmark: _Toc23068995][bookmark: _Toc23068994][bookmark: _Toc23068993][bookmark: _Toc23068992][bookmark: _Toc23068991][bookmark: _Toc23068990][bookmark: _Toc23068989][bookmark: _Toc23068988][bookmark: _Toc23068987][bookmark: _Toc23068986][bookmark: _Toc23068985][bookmark: _Toc23068984][bookmark: _Toc23068983][bookmark: _Toc23068982][bookmark: _Toc23068981][bookmark: _Toc23068980][bookmark: _Toc23068979][bookmark: _Toc23068978][bookmark: _Toc23068977][bookmark: _Toc23068976][bookmark: _Toc23068975][bookmark: _Toc75938731][bookmark: _Toc396387039][bookmark: _Ref5871947][bookmark: _Toc534108104][bookmark: _Toc513360304][bookmark: _Toc125363639]Asetukset>Yleiset asetukset
Vain käyttäjä, jolla on User Administration (Käyttäjähallinta) -oikeudet, voi muuttaa seuraavia määritysparametreja avaamalla General Settings (Yleiset asetukset) -valintaikkunan kohdassa Setup>General Settings (Asetukset>Yleiset asetukset). Yleiset asetukset tallentuvat zzzPAT-tietokantaan (erillisasennuksessa paikalliseen tietokantaan ja jaetussa asennuksessa jaettuun tietokantaan).

Nämä asetukset koskevat koko järjestelmää. Mukautetut asetukset ovat kaikkien käyttäjien saatavilla.

[bookmark: _Toc396387102]Kun kaikki muutokset asetuksiin on tehty, sulje General Settings (Yleiset asetukset) -valintaikkuna valitsemalla OK.
Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _Toc23069086][bookmark: _Toc23069085][bookmark: _Toc23069084][bookmark: _Toc23069083][bookmark: _Toc23069082][bookmark: _Toc23069081][bookmark: _Toc23069080][bookmark: _Toc23069079][bookmark: _Toc23069078][bookmark: _Toc23069077][bookmark: _Toc23069076][bookmark: _Toc23069075][bookmark: _Toc23069074][bookmark: _Toc23069073][bookmark: _Toc23069072][bookmark: _Toc23069071][bookmark: _Toc23069070][bookmark: _Toc23069069][bookmark: _Toc23069068][bookmark: _Toc23069067][bookmark: _Toc23069066][bookmark: _Toc23069065][bookmark: _Toc23069064][bookmark: _Toc23069063][bookmark: _Toc23069062][bookmark: _Toc23069061][bookmark: _Toc23069060][bookmark: _Toc23069059][bookmark: _Toc23069058][bookmark: _Toc23069057][bookmark: _Setup>General_Settings>Analysis/Sta][bookmark: _Toc23069056][bookmark: _Toc23069055][bookmark: _Toc23069054][bookmark: _Toc23069053][bookmark: _Toc23069052][bookmark: _Toc23069051][bookmark: _Toc23069050][bookmark: _Toc23069049][bookmark: _Toc23069048][bookmark: _Toc23069047][bookmark: _Toc23069046][bookmark: _Toc23069045][bookmark: _Toc23069044][bookmark: _Toc23069043][bookmark: _Toc23069042][bookmark: _Toc23069041][bookmark: _Toc23069040][bookmark: _Toc23069039][bookmark: _Toc23069038][bookmark: _Toc23069037][bookmark: _Toc23069036][bookmark: _Toc23069035][bookmark: _Toc23069034][bookmark: _Toc23069033][bookmark: _Toc23069032][bookmark: _Toc23069031][bookmark: _Toc23069030][bookmark: _Toc23069029][bookmark: _Toc23069028][bookmark: _Toc23069027][bookmark: _Toc23069026][bookmark: _Toc23069025][bookmark: _Toc23069024][bookmark: _Toc23069023][bookmark: _Toc23069022][bookmark: _Toc23069021][bookmark: _Toc75938732][bookmark: _Toc396387040][bookmark: _Toc125363640]zzzPAT-ohjelmiston käyttäminen
[bookmark: _Toc75938733][bookmark: _Ref449876863][bookmark: _Toc396387041][bookmark: _Toc125363641]Uuden tutkimuksen valmisteleminen
Potilastiedoston valmisteleminen on välttämätön osaWP-laitteiden valmistelua unitutkimukseen. 

zzzPAT-ohjelmiston käynnistäminen
Käynnistä zzzPAT (zzzPAT-tietokannan ohjattu asennustoiminto) napsauttamalla työpöydällä olevaa zzzPAT-kuvaketta [image: ].
Kun zzzPAT-kuvaketta [image: ] napsautetaan, esiin tulee sisäänkirjautumisikkuna:

Anna Login (Käyttäjätunnus) ja Password (Salasana). Kun jaettu käyttötila on asennettu, käyttäjä voi sisäänkirjautumisnäytössä valita, mihin tietokantaan zzzPAT muodostaa yhteyden. 
Sisäänkirjautumisikkunassa on kaksi eri kirjautumisvaihtoehtoa: 
· Active Directory (nykyinen toimialueen palvelin). 
· zzzPAT-tietokannan käyttäjät 

Valitse haluttu tietokanta, johon haluat yhteyden muodostaa (soveltuvin osin).
Anna käyttäjätunnus ja salasana ja jatka valitsemalla OK.

[bookmark: _Ref244001441]Uuden tutkimuksen valmisteleminen

Esiin tulee New study (Uusi tutkimus) -ikkuna, jossa on oletuslaitetyypin (WP200(U)/ WatchPAT™ 300/ WatchPAT™ ONE) ja kokoonpanon mukaiset kentät

Uuden tutkimuksen valmisteleminen (WP200(U)/ WatchPAT™ 300)

Varmista, että laite on yhdistetty tietokoneeseen ja zzzPAT-ohjelmistoon USB-kaapelilla.
Valitse zzzPAT-ohjelmistosta File>New Study Details (Tiedosto>Uuden tutkimuksen tiedot) tai napsauta työkalurivin New Study (Uusi tutkimus) -kuvaketta [image: ].
Esiin tulee New Study (Uusi tutkimus) -valintaikkuna.
Lisää pakollinen potilastunnus Patient (Potilas) -kenttiin. 
Lisää muita tietoja tarvittaessa. Muut kentät ovat vapaaehtoisia.
Valitse Pacemaker (Tahdistin), jos potilaalla on istutettava sydämentahdistin. zzzPAT tunnistaa automaattisesti segmentit, joissa PAT-pulssit vaikuttavat tahdistetuilta, esimerkiksi erittäin vähäiset sykkeen vaihtelut (lähellä tasaista), ja jättää ne pois analyysista.

	[image: clip_image002]
	Huomautus

	
	Tiettyjä tahdistintyyppejä ei saa käyttää WatchPAT-laitteen kanssa. Lisätietoja on laitteen käyttöoppaan vasta-aiheita käsittelevässä kohdassa.




Valitse Study with Tamper-Proof Testing (Tutkimus ja varmuustestaus), jos haluat käyttää potilasranneketta. Kun tämä vaihtoehto on otettu käyttöön, voit rannekkeen avulla varmistaa, että tunnistettu potilas todella nukkuu laitteen kanssa (katso WP-käyttöoppaan kohta Varmuustestaus).
Valitse Multiple Nights (Useita öitä), jos samaa WP-laitetta käytetään enintään 3 yönä.
WatchPAT™ 300: Run Device Test (Suorita laitetesti) -komento on esillä vain, kun laite on yhdistettynä. Kun tämä komento valitaan, yhdistetty laite testataan ja tulokset tulevat näkyviin erillisessä ikkunassa. Testin aikana tapahtuu sama Test Device (Testaa laite) -toiminto, joka suoritetaan erillislaitteesta käsin (katso WP-laitteen käyttöoppaan kohta Käyttäjän suorittamat testit.
WatchPAT™ 300: Run device test while saving... (Suorita laitetesti tallennettaessa...) -komento on esillä vain, kun laite on yhdistettynä. Kun tämä komento valitaan, yhdistetty laite testataan automaattisesti käyttäjän valitessa Save to WatchPAT (Tallenna WatchPAT-laitteeseen) -komennon ja tulokset tulevat näkyviin erillisessä ikkunassa. Testin aikana tapahtuu sama Test Device (Testaa laite) -toiminto, joka suoritetaan erillislaitteesta käsin.
Rekisteröi tutkimus WatchPAT™ ONE -laitteelle ”Switch to WP-ONE Device” (Vaihda WP-ONE-laitteeseen) -painikkeella.
Napsauta Save to WatchPAT (Tallenna WatchPAT-laitteeseen) -painiketta.


	[image: clip_image002]
	Huomautus

	
	New Study (Uusi tutkimus) -valintaikkunassa käytetyt painon ja pituuden yksiköt määräytyvät tietokoneen alueasetusten perusteella.



Jos WP-laitteessa on tietoja (yön aikainen tutkimus, jota ei ole ladattu zzzPAT-tietokantaan, tai uuden potilaan tiedot, jotka on valmisteltu mutta joita ei ole käytetty tutkimuksessa), esiin tulee Data Not Loaded (Tietoja ei ladattu) -valintaikkuna.
Kun potilastiedot on tallennettu WP-laitteeseen, esiin tuleva viesti ilmoittaa, että tutkimuksen tallennus onnistui.

Valitse Yes - (Kyllä -), jos haluat valmistella toisen tutkimuksen.
Valitse No - (Ei -), jos haluat sulkea New Study (Uusi tutkimus) -valintaikkunan.

Irrota USB-kaapeli laitteesta.

Uuden tutkimuksen valmisteleminen WatchPAT™ ONE -laitteella
Varmista, että internetyhteys on aktiivisena. 
Valitse zzzPAT-ohjelmistosta File>New Study Details (Tiedosto>Uuden tutkimuksen tiedot) tai napsauta työkalurivin New Study (Uusi tutkimus) -kuvaketta [image: ].
Esiin tulee New Study (Uusi tutkimus) -valintaikkuna.
Täytä pakolliset kentät: Patient ID (Potilastunnus), Device SN (Laitteen sarjanumero) ja PIN.
[bookmark: _Hlk527616295]Varmista, että esillä oleva sähköpostiosoite on oikein, jotta saat sähköposti-ilmoituksia (sähköpostiosoite määritetään asennuksen aikana).
Lisää muita tietoja tarvittaessa. Muut kentät ovat vapaaehtoisia.
Valitse Multiple Nights (Useampi yö) -vaihtoehto, jos haluat käyttää samaa WatchPAT™ ONE-M-laitetta enintään kolmena yönä (tämä edellyttää anturin vaihtoa joka ilta). Tämä vaihtoehto näytetään vain, kun ominaisuus on otettu käyttöön kohteessa Määritykset>Yleiset asetukset>Yleiset vaihtoehdot. Kun Multiple Nights (Useampi yö) -vaihtoehto valitaan, näkyviin tulevat valinnat 2 Nights (2 yötä) ja 3 Nights (3 yötä). Oletusvalinta riippuu kohdassa General Options (Yleiset vaihtoehdot) tehdyistä määrityksistä. Näkyviin tulee myös uusia vaadittuja tekstikenttiä, joihin lisätään lisäanturien sarjanumerot (SN).
Rekisteröi laite ja anturit napsauttamalla Register WP-ONE (Rekisteröi WP-ONE) -painiketta. Rekisteröinti epäonnistuu seuraavissa tapauksissa:
· Jokin SN-numeroista puuttuu tai ei kelpaa. 
· Jokin SN-numeroista on jo rekisteröity.
Aloita tutkimus WatchPAT™ 300- tai WP200)U( -laitteella napsauttamalla Switch to WP Device (Vaihda WP-laitteeseen) -painiketta.

	[image: clip_image002]
	Huomautus

	
	Jos sama WatchPAT™ ONE-laitteen sarjanumero on jo rekisteröity, esiin tuleva virheviesti kehottaa käyttäjää antamaan oikean / jonkin toisen sarjanumeron.
Täytä tiedot oikein ja napsauta Register WP-ONE (Rekisteröi WP-ONE) -painiketta uudestaan.



	
	

	
	New Study (Uusi tutkimus) -valintaikkunassa käytetyt painon ja pituuden yksiköt määräytyvät tietokoneen alueasetusten perusteella.




Kun potilastiedot on rekisteröity verkkopalvelimelle, esiin tuleva viesti ilmoittaa, että tutkimuksen tallennus onnistui:

Valitse Yes - (Kyllä -), jos haluat valmistella toisen tutkimuksen.
Valitse No - (Ei -), jos haluat sulkea New Study (Uusi tutkimus) -valintaikkunan.

New Study (Uusi tutkimus) -näytön ominaisuudet

Uuden tutkimuksen valmistelussa tarvittavien päänäytön kenttien lisäksi on ylimääräisiä kenttiä, joihin voi yksityiskohtaisesti kirjata potilaan aiemman ja nykyisen lääketieteellisen tilanteen. zzzPAT-ohjelmistossa voi lisäksi ladata potilastietoja aiemmista tutkimuksista. Näytön muilla ominaisuuksilla tutkimukset voi järjestellä haluamiinsa ryhmiin.

Lisätietoja on kattavassa kuvitetussa oppaassa.


[bookmark: _Toc513360269][bookmark: _Toc75938734][bookmark: _Toc396387042][bookmark: _Toc534108055][bookmark: _Toc502848059][bookmark: _Toc125363642]Potilastutkimusten hallitseminen
WP200(U)/ WatchPAT™ 300: Kun WP-unitutkimus on valmis, yhdistä WatchPAT-laite USB-asemaan, avaa zzzPAT-sovellus ja valitse päävalikosta File>Load Study and Analyze (Tiedosto>Lataa tutkimus ja analysoi). Tallennetut digitaaliset tiedot latautuvat zzzPAT-tietokantaan, ja järjestelmä analysoi ne automaattisesti. 
WatchPAT™ ONE: Kun WatchPAT™-unitutkimus on valmis, avaa zzzPAT-sovellus ja valitse päävalikosta File>Load Study and Analyze (Tiedosto>Lataa tutkimus ja analysoi). Esiin avautuvassa ikkunassa on luettelo kaikista rekisteröidyistä potilaista, joiden tutkimusta ei vielä ole haettu verkkopalvelimelta. Kun valitset ladattavan tutkimuksen, valitun potilaan tallennetut tiedot latautuvat zzzPAT-tietokantaan. Järjestelmä analysoi tallennetut tiedot automaattisesti. Kun tutkimus on ladattu, käyttäjä voi tarkastella, muokata ja lisätä diagnostiikka- ja suositustietoja ja luoda uniraportin. Aiemmin ladattuja tutkimuksia voi avata ja tarkastella.


	
[image: clip_image002]
	Huomautus

	
	Rekisteröityjen WatchPAT™ ONE-laitteiden luettelossa on Status (Tila) -sarake seuraavilla vaihtoehdoilla: Ready (Valmis), Not started (Ei aloitettu) ja In process (Käynnissä). Voit päivittää kaikkien rekisteröityjen laitteiden tilan painamalla Check Status (Tarkista tila) -painiketta.



	
[image: clip_image002]
	Huomautus

	
	Potilaita voidaan hakea Patient ID (Potilastunnus) -tunnuksella ja laitteita Device SN (Laitteen sarjanumero) -numerolla.




	
[image: clip_image002]
	Huomautus

	
	Jos haluat vaihtaa pois WatchPAT™ ONE -laitteen rekisteröityjen potilaiden luettelosta ladataksesi tutkimuksen WP200(U)-/ WatchPAT™ 300 ‑laitteelta, valitse ”Switch to WP200/300 Device” (Vaihda WP200/300-laitteeseen) -painike.



[bookmark: _Toc534108056]Tiedosto>Uuden tutkimuksen tiedot

Valmistelee WP-laitteessa olevan potilastiedoston unitutkimusta varten (kohta 4.1).

[bookmark: _Toc534108057]Tiedosto>Lataa tutkimus ja analysoi

Tällä komennolla lataat unitutkimuksen tiedot laitteesta ja tallennat ne zzzPAT-tietokantaan.
Tietoja ladattaessa esiin tulee viesti Loading Study (Tutkimusta ladataan). Se tarkoittaa, että tietoja siirretään WatchPAT-laitteesta kiintolevylle ja että potilastiedosto tallennetaan tietokantaan.
[bookmark: _Toc534108058]Tässä vaiheessa järjestelmä tekee automaattisen analyysin ja tallentaa tulokset tietokantaan. Kun automaattinen analyysi on valmis, tulokset tulevat esiin näyttöön. Käyttäjä voi halutessaan tarkastella uniraporttia (Sleep report).

WP200(U)/WP300: Kun usean yön tutkimusta ladataan, kaikkien öiden tutkimukset latautuvat automaattisesti ja viimeksi ladattu tutkimus avautuu näyttöön. Avaa ja tarkastele kaikkien öiden tutkimuksia avaamalla Open Study (Avaa tutkimus) -valintaikkuna. 
	
[image: clip_image002]
	Huomautus

	
	Kun tutkimusta ladataan WatchPAT™ 300 -laitteella, laiteohjelmiston versio tarkastetaan. Jos laitteessa ei ole uusinta laiteohjelmistoversiota asennettuna, esiin tulee seuraava ilmoitus:
”Uudempi laiteohjelmistoversio on saatavilla laitteelle numero XXX. Uusimman laiteohjelmistoversion käyttöä suositellaan.
Lataa päivitetty ohjelmisto kohdasta 'Help'->'Visit our Web Page for Upgrading Watch-PAT Device' (Ohje->Päivitä Watch-PAT-laite verkkosivustoltamme).”
Katso laiteohjelmistoversion päivittämistä koskevia lisätietoja kohdasta 5.8.



[bookmark: _Ref5870366][bookmark: _Ref449882566]
Tiedosto>Avaa tutkimus 

Avaa zzzPAT-tietokantaan tallennetut tutkimukset aiemmin ladatuista tutkimuksista. Kun kaksoisnapsautat potilasta, esiin tulee luettelo hänen tutkimuksistaan ja jokaisen tutkimuksen päiväys/aika. Lataa ja tarkastele tallennettuja tietoja näytössä kaksoisnapsauttamalla [image: ]-tutkimuskuvaketta. 
Jos samassa tutkimuksessa on tehty useita analyyseja, esiin tulevassa valintaikkunassa käyttäjää kehotetaan valitsemaan avattava analyysi.

Select Studies (Valitse tutkimukset) -painike
Käyttäjä voi määrittää, valita ja organisoida Select Patient Study (Valitse potilastutkimus) -valintaikkunassa näkyviä tutkimuksia.
Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _Toc534108061][bookmark: _Toc534108062]Tiedosto>Tallenna tutkimustulokset

Tallentaa tarkasteltavana olevat potilastutkimuksen tulokset (tapahtumat) sulkematta zzzPAT-ohjelmistoa ja määrittää tutkimuksen tarkastetuksi. Ominaisuutta tarvitaan, kun hengitystapahtumia muokataan (lisätään tai poistetaan) ja uusia tapahtumia on tallennettavia tulevia zzzPAT-istuntoja varten.

Tiedosto>Tallenna uutena analyysina

Tallentaa nykyisen analyysin sekä nykyiset tapahtumat ja signaalit uudeksi analyysiksi. 

Tiedosto > Sulje tutkimus

Sulkee tarkasteltavana olevan potilastutkimuksen sulkematta zzzPAT-ohjelmistoa.

Tiedosto>Sulje 

Sulkee sekä tarkasteltavan potilastutkimuksen että zzzPAT-ohjelmiston.

[bookmark: _Ref54576982][bookmark: _Toc534108063][bookmark: _Toc513360270][bookmark: _Ref508254354]Muokkaa>Tutkimuksen tiedot

Avaa View>Study Details (Näytä>tutkimuksen tiedot) -valintaikkunan ja tuo esiin nykyisen potilaan tiedot. Tietoja voi muokata napsauttamalla Edit (Muokkaa) -painiketta. Valtuutetut käyttäjät voivat muuttaa potilastunnusta vain kerran.

Muokkaa>Kumoa
Käyttäjä voi kumota edellisen toiminnon valitsemalla Undo (Kumoa) tai zzzPAT-ohjelmiston työkaluriviltä [image: ]. 

Muokkaa>Univaiheiden muokkaus hiirellä
Kun toiminto [image: ] valitaan tai sitä napsautetaan, sen tila zzzPAT-ohjelmiston työkalurivillä vaihtuu niin, että käyttäjä voimuokata unen vaiheita ja CSR-aikoja hiirellä. Jos käyttäjä valitsee toiminnon ja siirtää hiiren kohdistimen unen vaihetta kuvaavan tapahtuman päälle (eli Light Sleep [Kevyt uni]), hiiren nuoli muuttuu käsikuvakkeeksi. Valittua tapahtumaa voi sen jälkeen vetää tai sen kokoa muuttaa. 

[bookmark: _Toc448932666]Muokkaa>Kopioi…
Kun signaaliosio on korostettuna, Copy (Kopioi) -ominaisuus on käytettävissä. Käyttäjä voi sillä kopioida halutut tiedot joko leikepöydälle kuvana tai tiedostoon binäärimuodossa.
[bookmark: _Toc75938735][bookmark: _Ref519084358][bookmark: _Toc396387043][bookmark: _Toc125363643]Näyttöruutu

Päänäytössä näkyvät WP-laitteen tallentamat aaltomuodot sekä automaattisen analyysin havaitsemat tapahtumat. Käyrät näkyvät synkronoituina yhtenäiseen perusaikaan.

[bookmark: _Ref66728932]Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _The_All_Night][bookmark: _Ref6238670][bookmark: _Toc534108064][bookmark: _Toc513360271][bookmark: _Ref520722074]Koko yön näkymä  ja tarkasteltavat kanavat

Mitä tahansa valittua kanavaa voi tarkastella All Night Window (Koko yön näyttö) -näkymässä, vaikka tutkimuksen kaikkien tarkasteltavien kanavien aikajakso muuttuisi.
Avaa koko yön näkymä valitsemalla View>All Night Window (Näytä>Koko yön näyttö) ja valitsemalla vaihtoehto All Night (Koko yö).
Voit valita myös View>Channels (Näytä>Kanavat).
Valitse Visible (Näkyvissä) -kohdan vasemmalla puolella All Night (Koko yö) -osassa oleva valintaruutu.
Valitse kanava, jota haluat All Night Window (Koko yön näyttö) -näkymässä tarkastella.

Lisätietoja on kattavassa kuvitetussa oppaassa.

[bookmark: _Toc513360272][bookmark: _Toc534108065]
[bookmark: _Toc534108067][bookmark: _Toc513360275]Aktiivinen kanava

Kanavan voi aktivoida napsauttamalla joko kanavaa tai sen otsikkoa (aktivoidun signaalin ja otsikoiden väri muuttuu).


Kun kanavan otsikkoa napsautetaan hiiren kakkospainikkeella, kanava aktivoituu ja esiin tulee ponnahdusvalikko. 

[bookmark: _Toc513360284][bookmark: _Toc534108068]
Tilarivi

 näytön alareunassa on seuraavat tiedot:
Tietokantayhteys (jaettu tai paikallinen)
Reaaliaikainen kello
Korostetun segmentin alkamisaika
Korostetun segmentin päättymisaika
Kesto
Aikatila (REL/ABS [SUHTEELLINEN/ABSOLUUTTINEN)
[bookmark: _Toc75938736][bookmark: _Ref520722093][bookmark: _Toc396387044][bookmark: _Toc534108069][bookmark: _Toc513360276][bookmark: _Toc125363644]Signaalin esitysvaihtoehdot
[bookmark: _Ref519093479][bookmark: _Toc513360273][bookmark: _Toc534108070]Näytä>Määritä montaasin kanavat 
Montage (Montaasi) -näytössä on luettelo kaikista tarkasteltavista signaalikanavista:
PAT – PAT-signaali.
Syke – johdettu PAT-signaalista.
PAT-amplitudi – PAT-signaalin taajuus.
SpO2 – Verisuonten happisaturaatiotaso.
Aktigrafi – aktigrafisignaali.
WP-laitteen tallentamat univaiheet – REM, kevyt uni, syvä uni ja hereillä olo.
Vartalon asento (lisävaruste)
Kuorsaus (lisävaruste)
Hengitysliikkeet (lisävaruste)

Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _Toc23069146][bookmark: _Toc23069145][bookmark: _Toc23069144][bookmark: _Toc23069143][bookmark: _Toc23069142][bookmark: _Toc23069141][bookmark: _Toc23069140][bookmark: _Toc23069139][bookmark: _Toc23069138][bookmark: _Toc23069137][bookmark: _Toc23069136][bookmark: _Toc23069135][bookmark: _Toc23069134][bookmark: _Toc23069133][bookmark: _Toc23069132][bookmark: _Toc23069131][bookmark: _Toc23069130][bookmark: _Toc23069129][bookmark: _Toc23069128][bookmark: _Toc23069127][bookmark: _Toc23069126][bookmark: _Toc23069125][bookmark: _Toc23069124][bookmark: _Toc23069123][bookmark: _Toc23069122][bookmark: _Toc23069121][bookmark: _Toc23069120][bookmark: _Toc23069119][bookmark: _Toc23069118][bookmark: _Toc23069117][bookmark: _Toc23069116][bookmark: _Toc23069115][bookmark: _Toc23069114][bookmark: _Toc23069113][bookmark: _Toc23069112][bookmark: _Toc23069111][bookmark: _Toc23069110][bookmark: _Toc23069109][bookmark: _Toc23069108][bookmark: _Toc23069107][bookmark: _Toc23069106][bookmark: _Toc23069105][bookmark: _Toc23069104][bookmark: _Toc23069103][bookmark: _Toc23069102][bookmark: _Toc23069101][bookmark: _Toc23069100][bookmark: _Toc23069099][bookmark: _Toc23069098][bookmark: _Toc23069097][bookmark: _Toc23069096][bookmark: _Toc23069095][bookmark: _Toc23069094][bookmark: _Toc23069093][bookmark: _Toc23069092][bookmark: _Toc75938737][bookmark: _Toc396387045][bookmark: _Toc534108081][bookmark: _Toc513360285][bookmark: _Ref508258348][bookmark: _Ref508258341][bookmark: _Ref508258251][bookmark: _Ref508258225][bookmark: _Toc502848060][bookmark: _Toc125363645]Tutkimuksen tarkastelu, analysointi ja raportointi
[bookmark: _Toc513360286][bookmark: _Toc534108082]Tietojen analyysi
zzzPAT-ohjelmisto analysoi WP-laitteen tallentamat signaalit automaattisesti. Analysoinnissa arvioidaan unen aikaisia hengityshäiriöitä, happisaturaatiota, sykettä ja unen eri vaiheiden tilastotietoja. Jos käytössä on SBP/RESBP-anturi, analyysissa saadaan myös kuorsauksen ja vartalon asennon tilastotietoja.

[bookmark: _Toc534108098][bookmark: _Toc513360298]Analyysin luominen
Järjestelmä analysoi tallennetut tutkimustiedot automaattisesti sen jälkeen, kun ne on ladattu laitteesta. Automaattisen tietojen analyysin voi käynnistää myös valitsemalla Analyze>Reload study and analyze (Analysoi>Lataa tutkimus uudestaan ja analysoi).
Tämä toiminto lataa tallennetut tutkimustiedot uudestaan ja tekee automaattisen analyysin. Jos käyttäjä on muuttanut tiedostoa (lisännyt/poistanut/muokannut tapahtumia), muutokset häviävät eivätkä vaikuta analyysiin.
Kun toimintoa käytetään tiedostossa, joka on aiemmin analysoitu ja tallennettu zzzPAT-ohjelmiston vanhemmalla versiolla, se tekee uuden analyysin zzzPAT-ohjelmiston nykyisellä versiolla.

REM-analyysi on osa automaattista analyysia edellä kuvatun mukaisesti. 
Tietyissä tilanteissa järjestelmä ei REM-analyysilla pysty aukottomasti määrittämään REM-unijaksoja tallennetuista signaaleista. 
Kun näin käy, näkyvissä ovat vain unen ja valveilla olon vaiheet. Raportissa REM-jakson ja univaiheiden tilastotietokohdat ovat poissa käytöstä. Niiden tilalla lukee Inconclusive REM Detection (REM-jaksoja ei voitu luotettavasti havaita).
Tapahtumien hallitseminen

Automaattisen analyysin merkitsemät tapahtumat näkyvät värillisissä laatikoissa. Kun hiiren kohdistin viedään tapahtuman päälle, esiin tulevassa työkaluvihjeessä näkyvät seuraavat tiedot:
Tapahtuman nimi
Tapahtuman muodostaja (esimerkiksi automaattinen analyysi tai käyttäjä)
Alkamisaika
Kesto

Lisätietoja on kattavassa kuvitetussa oppaassa.
[bookmark: _Adding_events][bookmark: _Ref54689320][bookmark: _Toc534108092][bookmark: _Toc513360296]
[bookmark: _Toc125363646]Raportit
Kaikkia raportteja voi tarkastella näytössä ja tulostaa. 
Raportin tarkastelutilassa työkalurivillä ovat seuraavat toiminnot:
Tulosta raportti napsauttamalla Print (Tulosta) -painiketta.
Vie raportti toiseen tiedostomuotoon, esimerkiksi pdf, rtf tai html, napsauttamalla Export (Vie) -painiketta.
[bookmark: _Ref530981062][bookmark: _Toc534108093]Käyttäjä näkee, kuinka monta sivua raportissa on,  ja voi valita tarkasteltavan sivun [image: rep3]-kuvakkeilla.

Lisätietoja on kattavassa kuvitetussa oppaassa.

0. [bookmark: _Report>Sleep_Report][bookmark: _Ref6288001][bookmark: _Toc534108094][bookmark: _Ref434171410]Raportti>Kliininen diagnoosi
Tämän ominaisuuden avulla Sleep Report (Uniraportti) -näyttöön voidaan lisätä diagnoosi ja suosituksia. Tähän näyttöön lisätyt tiedot näkyvät uniraportin ensimmäisellä sivulla. 
· Voit allekirjoittaa raportin kirjoittamalla nimesi tai valitsemalla sen valikkopalkista.
· Valitse Set as Reported (Merkitse raportoiduksi) -valintaruutu, joka osoittaa nykyisen tutkimuksen analyysin olevan lopullinen ja että uniraportti on kyseessä olevan analyysin lopullinen raportti.
· Valitse No AHI Central Statistics (Ei keskeisiä AHI-tilastoja) -valintaruutu, jos haluat jättää keskeiset apneatilastot pois raportista.
· Valitse Send to HL7 (Lähetä HL7:ään) -valintaruutu kyseessä olevan tutkimuksen lähettämiseksi HL7:ään, kun HL7-palvelu on asennettuna ja käytössä. Huomaa, että valintaruutu on valittava kunkin HL7:ään lähetettävän tutkimuksen kohdalla.

Raportti>Uniraportti
Uniraportti on yksi-, kaksi-, neljä- tai viisisivuinen raportti, jossa annetaan asetusten mukainen yhteenveto potilaan unitutkimuksesta. 
Raportin ensimmäisellä sivulla on seuraavat osat: Patient Information (Potilastiedot), Sleep Study Information (Unitutkimuksen tiedot), Referring Physician (Lähettävä lääkäri), Medical history (Sairauskertomus), Diagnosis (Diagnoosi) ja Recommendations (Suositukset). 

Toisella sivulla ovat tutkimuksen tulokset: unitietojen yhteenveto, PAT-hengityshäiriöindeksi (pRDI), PAT-apnea-hypopneaindeksi (pAHI), apnea-hypopnean PAT-keski-indeksi (pAHIc)*, tapahtumien lukumäärä, prosenttiosuus kokonaisuniajasta Cheyne-Stokesin hengityskaavalla (%CSR)*, happisaturaation tilastotiedot, kuten happidesaturaatioindeksi (ODI), happisaturaatiotasojen keskiarvot sekä vähimmäis- ja enimmäisarvot, happisaturaatioanalyysi, sykkeen tilastotiedot, REM-unianalyysi ja AHI-vakavuustasokaavio.

Kolmannella sivulla esitetään graafisessa muodossa hengitystapahtumat, kuorsauksen ja vartalon asennon kaavio (jos vastaavaa anturia on käytetty), happisaturaatio, syke, PAT-amplitudi, unen eri vaiheet (hereillä / kevyt uni / syvä uni ja REM). 

Neljännellä sivulla esitetään ympyräkaavioina hereillä ja unessa olo, unen eri vaiheet, nukahtamisviive, REM-unen viive, yöllisten heräämisten määrä sekä unen tehokkuuden, kuorsauksen ja vartalon asennon tilastotiedot (jos vastaava anturi on ollut käytössä).

Uniraportin viides sivu (valinnainen) on valinnainen sivu, jota ei tulosteta oletusarvoisesti. Jos haluat tulostaa tämän sivun, valitse Oximetry and Pulse Rate Histogram Page in Sleep Report (Oksimetrian ja pulssin histogrammisivu uniraportissa) -valintaruutu kohdassa General Settings (Yleiset asetukset) (katso osio 3.3.7). Sivulla näytetään seuraavat oksimetria- ja pulssihistogrammit:
· Happisaturaatiojakauma: sekuntien määrä kutakin happisaturaatioarvoa kohden.
· Desaturaatiotapahtumien määrä kutakin happisaturaation resaturaatiohuippua kohden. 
· Desaturaatiotapahtumien määrä kutakin desaturaatiopohjalukemaa kohden.
· Desaturaatiotapahtumien määrä kutakin desaturaatiotapahtuman vähimmäislukemaa (nadir) kohden.
· Pulssijakauma: sekuntien määrä kutakin pulssiarvoa kohden.

Histogrammit ovat tyhjiä, jos kelpoista uniaikaa ei ole kertynyt lainkaan.


*pAHIc- ja %CSR -tiedot ovat mukana raportissa, jos RESBP-anturia on käytetty. pAHIc- ja %CSR-arvot käyvät ilmi raportista, mikäli sääntelyviranomaiset ovat ne kyseisessä maassa hyväksyneet.


Määritelmät:

Uniaika: Kokonaisaika tunteina, jonka potilas on ollut unessa. 

PAT-hengityshäiriöindeksi (pRDI): hengitystapahtumien arvioitu määrä jaettuna kelvollisella uniajalla. Tulos esitetään raportissa hengitystapahtumina tunnissa. Indeksi lasketaan koko yön kelvollisesta uniajasta (REM ja muu kuin REM).

PAT-apnea-hypopneaindeksi (pAHI): apnea- ja hypopneatapahtumien arvioitu määrä jaettuna kelvollisella uniajalla. Tulos esitetään raportissa apnea- ja hypopneatapahtumien määränä tunnissa. Indeksi lasketaan koko yön kelvollisesta uniajasta (REM ja muu kuin REM).

Apnea-hypopnean PAT-keski-indeksi (pAHIc): sentraalisten apneatapahtumien ja hypopneatapahtumien arvioitu määrä jaettuna kelvollisella uniajalla. Tulos esitetään raportissa sentraalisten apneatapahtumien ja hypopneatapahtumien määränä tunnissa.

Prosenttiosuus kokonaisuniajasta Cheyne-Stokesin hengityskaavalla (%CSR): CSR-kaavan arvioitu prosenttiosuus kelvollisesta uniajasta*.

*pAHIc- ja %CSR -arvoissa käytetty kelvollinen uniaika saattaa poiketa muiden indeksien laskemisessa käytetystä kelvollisesta uniajasta, koska RESBP-anturin on oltava kelvollinen myös tässä laskelmassa.

Happidesaturaatioindeksi (ODI): happidesaturaatiotapahtumien määrä (määritetty vähimmäisdesaturaatioarvo, 3 tai 4 %) jaettuna kelvollisella uniajalla. Tulos esitetään raportissa desaturaatiotapahtumina tunnissa. Indeksi lasketaan koko yön kelvollisesta uniajasta (REM ja muu kuin REM).

REM, prosenttiosuus uniajasta: REM-univaiheiden prosenttiosuus kokonaisuniajasta.

Kuorsaustaso desibeleinä: Koska kuorsaaminen voi olla merkki uniapneasta, zzzPAT-ohjelmisto tuottaa tilastotietoja kuorsaamisesta. Kynnysarvo määritetään desibeleinä.  Kuorsaamisen määrää arvioidessa lasketaan, kuinka suuri prosenttiosuus uniajasta ylittää desibeleinä määritetyn kynnysarvon.  Kuorsauksen äänenvoimakkuustaso näkyy graafisena esityksenä (välillä 40–70 dB).

Vartalon asento: Viisi vartalon asentoa näkyy graafisessa muodossa: selällään, vatsallaan, vasemmalla tai oikealla kyljellä, istuen. Koska apneatapahtumien taajuus unen aikana määräytyy potilaan asennon ja univaiheen mukaan, zzzPAT-ohjelmisto ilmoittaa, kuinka kauan potilas nukkui kussakin asennossa: selällään, vatsallaan, vasemmalla tai oikealla kyljellä, istuen. Ohjelmisto esittää kaaviona kussakin asennossa vietetyn uniajan prosenttiosuudet. Lisäksi raportissa ovat mukana tallentuneet tapahtumat, kuten hengityshäiriöindeksi (pRDI), apnea-hypopneaindeksi (pAHI) ja desaturaatioindeksi (ODI), jokaisessa vartalon asennossa (myös muissa asennoissa kuin selinmakuulla).

AHI-vakavuustasokaavio:  Ilmoittaa obstruktiivisen uniapnean vakavuustason. Yhdysvaltalainen unitutkimusjärjestö American Academy of Sleep Medicine (AASM) luokittelee apnean seuraaviin tasoihin: lievä (5–15 tapahtumaa tunnissa), keskivaikea (15–30 tapahtumaa tunnissa) ja vaikea (>30 tapahtumaa tunnissa). Vakavuustasojen raja-arvoja voi muokata kohdassa Setup>General Settings>Analysis/Statistics Parameters (Asetukset>Yleiset asetukset>Analyysin/tilastotietojen parametrit).
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[bookmark: _Toc534108095]Raportti>Uniraportti valitulta aikajaksolta

Tämä toiminto luo kaksisivuisen yhteenvetoraportin tutkittavan unitutkimuksesta käyttäjän valitsemalta aikajaksolta (Selected Time Range).

Luo raportti valitulta aikajaksolta seuraavalla tavalla:
· Korosta aaltomuodon haluttu osa signaalien näyttöikkunassa napsauttamalla ja hiirellä vetämällä.
· Valitse Report>Sleep Report for Selected Time Range (Raportti>Uniraportti valitulta aikajaksolta).

Lisätietoja on kattavassa kuvitetussa oppaassa.

Raportti>Tapahtumaraportti

Raportissa on tilastotiedot zzzPAT-ohjelmiston automaattisen analyysin ja käyttäjän havaitsemista erityyppisistä tapahtumista.  Graafisesta esityksestä näkee nopeasti tapahtumien jakauman, ja yhteenvetokohdassa on tilastotietoja. Kun tapahtuma näkyy ruudussa, käyttäjä voi avata tarkan luettelon kaikista tietyn tyyppisistä tapahtumista kaksoisnapsauttamalla tiettyä tapahtuman nimeä (halutulla rivillä kaavion alapuolella).
[bookmark: _Ref67056148][bookmark: _Toc534108096]Raportti>Uni-indeksit

Tässä raportissa on yhteenveto tutkimustuloksista, muun muassa pRDI, pAHI, ODI ja uniaika.
Raportti>Potilaan seurantaraportti

Tässä raportissa voi vertailla saman potilaan useita tutkimuksia. Tutkimusten välisiä trendejä on helppo havaita, sillä arvot pRDI, pAHI ja ODI esitetään graafisessa muodossa.
Näkyvissä on myös unen prosenttiosuus (Sleep %), jolloin kuorsauksen desibeleinä määritetty kynnysarvo ylittyy. 

Raportti>Potilasraportti

Tämä raportti on kirjemuodossa potilaalle laadittu esitys, jossa kerrotaan unitutkimuksen tuloksista. Se sisältää seuraavat potilastiedot:
· Kokonaisuniaika
· Apnea-hypopneaindeksi (AHI)
· Hengityshäiriöindeksi (RDI)
· Desaturaatioindeksi (ODI)
· Vilkeuni (REM)
Se myös vertaa saatuja arvoja tavanomaisiin indeksikeskiarvoihin.


	[bookmark: _Hlk97757100][image: clip_image002]
	Huomautus

	
	zzzPAT-asennuksen yhteydessä asennetaan kolme eri patientletter.ini-tiedostoa: yksi miehille, yksi naisille ja yksi oletustiedosto. Jos potilaan sukupuoli on määritetty, potilasraportin laadinnan yhteydessä näytetään kyseinen malli, jos käytössä oleva kieli erottelee eri sukupuolet. Jos potilaan sukupuolta ei ole määritetty, näytetään mieheen viittaava malli.




Luo potilaalle tarkoitettu raportti seuraavalla tavalla:
1. Valitse Report (Raportti) -valikosta Report for Patient (Potilasraportti).
2. Tulosta raportti napsauttamalla tulostinkuvaketta.

[bookmark: _Ref96585667][bookmark: _Hlk97757151]Raportti > Yksityiskohtainen raportti

[bookmark: _Hlk97757231]Tämän raportin ensimmäinen sivu on sama kuin uniraportin. Muilta raportin sivuilta löytyy graafisia esityksiä hengitystapahtumista, kuorsaamisesta ja vartalon asennosta kertova kaavio (kun testissä käytettiin kuorsausta ja vartalon asentoa mittaavaa anturia), happisaturaatio, pulssi, PAT-amplitudi ja tietoa hereillä olosta / kevyestä unesta / syvästä unesta sekä REM-vaiheista. Kukin sivu edustaa yhtä unituntia.

[bookmark: _Hlk97757352]Raportti > Useamman yön yhteenvetoraportti

Tässä yhteenvetoraportissa esitetään useamman yön unitilastot. Raportti on käytettävissä vain, kun avoinna oleva tutkimus sisältää useamman yön  WatchPAT™ ONE-tietoja (katso osiosta 4.1.2.2 tietoa uuden WatchPAT™ ONE-tutkimuksen suorittamisesta useamman yön ominaisuutta käyttäen). Raporttiin sisältyy enintään kolme tutkimusta (yksi kutakin saraketta kohden). Kunkin tutkimuksen WatchPAT™ ONE-laitetta ja potilasta koskevat tiedot ovat samat. Raportissa on lisäksi sarake, jossa näytetään tutkimuksen arvojen keskiarvot (katso alta).
[bookmark: _Toc534108112][bookmark: _Toc513360313][bookmark: _Toc513360297][bookmark: _Toc534108097]Tulostaminen

WatchPAT™-laitteen tallentamat ja zzzPAT-ohjelmiston analysoimat tutkimussignaalit voi tulostaa seuraavilla tavoilla:
Napsauta työkalurivin tulostuskuvaketta [image: Print Screen Icon] tai valitse File>Print (Tiedosto>Tulosta).
Käyttäjällä on useita eri tulostusvaihtoehtoja:
Koko tutkimus
Näyttö
Tietyt osat aikajakson mukaan
Tietyt kanavat

[bookmark: _Toc75938739][bookmark: _Toc396387047][bookmark: _Ref6148213][bookmark: _Toc534108109][bookmark: _Toc513360310][bookmark: _Toc125363647]Tietojen vieminen
Lisätietoja on kattavassa kuvitetussa oppaassa.
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[bookmark: _Ref299442665][bookmark: _Toc396387061][bookmark: _Ref97006805]Lisätietoja on kattavassa kuvitetussa oppaassa.

[bookmark: _Toc75938741][bookmark: _Toc396387065][bookmark: _Toc125363649]Tietokannan ohjattu asennustoiminto
[bookmark: _Hlk101182353]Lisätietoja on kattavassa kuvitetussa oppaassa.
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	Asentaminen

	Ongelma
	Mahdollinen syy
	Ratkaisu

	zzzPAT-asennustiedosto ei käynnisty.
	Automaattista käynnistymistoimintoa ei ole aktivoitu Windowsissa.
	Siirry hakemistoon My Computer>zzzPAT CD ja kaksoisnapsauta tiedostoa Setup.exe.

	
	Windows-versio ei ole yhteensopiva zzzPAT-ohjelmiston kanssa.

	Käytä tietokonetta, jonka käyttöjärjestelmä on yhteensopiva.

	
	Laitteistokokoonpano ei täytä vähimmäisvaatimuksia.
	zzzPAT-asennustiedosto tarvitsee vähintään 128 megatavua RAM-muistia ja Pentium-prosessorin.

	zzzPAT ei tunnista WatchPAT-ohjelmistoa
(vain WP200)
	
USB-asema on määritettävä uudestaan.
	
Valitse Setup>Set WatchPAT Drive (Asetukset>Määritä WatchPAT-asema).  Aseta WatchPAT-laite USB-asemaan.
Valitse OK.
Esiin pitäisi tulla viesti The system is searching for WatchPAT device (Järjestelmä etsii WatchPAT-laitetta).
Lopuksi esiin pitäisi tulla luettelo, jossa WP200-asema on mukana.
Valitse ensin WatchPAT-asema ja sitten OK.


	Windows XP -käyttöjärjestelmässä käyttäjä ei voi ladata tutkimusta tai käyttää tietokannan ohjatun asennustoiminnon apuohjelmia, vaikka hänellä olisi asianmukaiset zzzPAT-käyttöoikeudet.
	Käyttäjällä ei ole kirjoitusoikeuksia asemiin, joissa sovellukset sijaitsevat. 
	Tarkista käyttäjän osiokohtaiset kirjoitusoikeudet ja määritä uudelleen tarpeen mukaan. 
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	[bookmark: _Toc30911226][bookmark: _Toc534108126]zzzPAT

	Ongelma
	Mahdollinen syy
	Ratkaisu

	zzzPAT-ikkunan Analyze>Reload Study and Analyze (Analysoi>Lataa tutkimus uudestaan ja analysoi) -komento ei ole käytössä
	Käyttäjällä ei ole oikeuksia tämän apuohjelman käyttämiseen.
	zzzPAT-järjestelmänvalvoja voi muokata käyttäjän laajennettuja käyttöoikeuksia. 

	
	Kiintolevyllä ei ole riittävästi vapaata tilaa
	Vapauta riittävästi levytilaa (vähimmäisvaatimus 100 Mt) ja yritä uudestaan

	Load Study (Lataa tutkimus) -komento ei ole käytössä
	Vapaata levytilaa on alle 200 Mt
	Vapauta riittävästi levytilaa (vähimmäisvaatimus 200 Mt) ja yritä uudestaan

	zzzPAT ei käynnisty tai toimii arvaamattomasti
	Jotkin zzzPAT-tiedostot ovat ehkä vioittuneet tai ne on ylikirjoitettu
	Poista zzzPAT-ohjelmiston asennus ja asenna se uudestaan. 

	Avatussa tiedostossa ei näy REM-unen tietoja 
	Tiedosto on tallennettu zzzPAT-ohjelmiston vanhemmalla versiolla, jossa ei ollut REM-ominaisuuksia tai REM-unen tietoja ei voitu laskea algoritmin rajoitusten takia.
	Aja analyysi valitsemalla Analyze>Reload Study and Analyze (Analysoi>Lataa tutkimus uudestaan ja analysoi)

	Uniraporttia ei voi luoda, Sleep Report (Uniraportti) -painike näkyy harmaana
	Vapaata levytilaa on alle 100 Mt
	Vapauta riittävästi levytilaa (vähimmäisvaatimus 100 Mt) ja yritä uudestaan

	
	Tutkimuksia ei ole ladattu tai tutkimus ei kelpaa
	Avaa haluttu tutkimus. Jos tutkimus on jo avattu, siinä saattaa olla viallisia tietoja, joita ei voi käyttää

	Käyttäjä ei voi kirjautua zzzPAT-ohjelmistoon
	zzzPAT ei avaudu, jos toisella käyttäjällä on auki toinen istunto
	Varmista, että kukaan muu käyttäjä ei ole jättänyt tietokoneelle auki zzzPAT-istuntoa. Jos varmentaminen ei onnistu, käynnistä tietokone uudestaan

	
	Käyttäjää ei ole määritetty zzzPAT-ohjelmistossa
	zzzPAT-järjestelmänvalvojan on määritettävä käyttäjä

	Raportin lähettäminen sähköpostitse epäonnistuu
	Microsoft Outlookia ei ole määritetty oletusarvoiseksi sähköpostiohjelmaksi.
	Määritä Microsoft Outlook (tai Outlook Express) oletusarvoiseksi sähköpostiohjelmaksi

	Tapahtumien nimiin tehdyt muutokset eivät näy näytössä
	Tapahtumien nimet tallentuvat analyysin mukana. Muutokset näkyvät vasta, kun analyysi on ajettu uudestaan
	Aja analyysi valitsemalla Analyze>Reload Study and Analyze (Analysoi>Lataa tutkimus uudestaan ja analysoi)

	Tulostettaessa esiintyy virheitä
	Tulostinohjain ei ole yhteensopiva
	Postscript-tulostinohjain toimii luotettavimmin zzzPAT-ohjelmiston kanssa. Asenna käytettävään tulostimeen sopiva postscript-tulostinohjain ja yritä uudestaan.

	Kun valitset zzzPAT-ohjelmistosta New Study (Uusi tutkimus), valintaikkuna katoaa ja zzzPAT jäätyy
	Jos New Patient (Uusi potilas) -painiketta kaksoisnapsautetaan vahingossa, valintaikkuna saattaa olla piilossa taustalla
	Tuo valintaikkuna takaisin etualalle näppäimillä Alt+Tab

	New Study (Uusi tutkimus) -valintaikkunassa ei ole Enable multi-night option (Ota käyttöön usean yön vaihtoehto) -asetusta
	WP-laitteen ohjelmistoversio on vanhempi kuin 2.2182
	Päivitä WP-laitteeseen uusin ohjelmistoversio (pyydä päivitystä Itamar-käyttäjätuesta)

	New Study (Uusi tutkimus) -valintaikkunassa ei ole Enable tamper-proof testing (Ota käyttöön varmuustestaus) -asetusta
	WP-laitteen ohjelmistoversio on vanhempi kuin 2.2182
	Päivitä WP-laitteeseen uusin ohjelmistoversio (pyydä päivitystä Itamar-käyttäjätuesta)

	Kuorsaukseen ja vartalon asentoon liittyviä tietoja ei näy 
	SBP/RESBP-anturia ei ole yhdistetty WP-laitteeseen
	Varmista, että SBP on yhdistetty WP-laitteeseen.
Varmista, että RESBP on yhdistetty vain WP200U- tai WatchPAT™ 300-laitteeseen

	
	RESBP-anturi on yhdistetty WP200-laitteeseen WP200U/ WatchPAT™ 300-laitteen sijasta
	Varmista, että RESBP on yhdistetty vain WP200U- tai WatchPAT™ 300-laitteeseen

	
	Ohjelmistoversio ei ole yhteensopiva
	WP200U-laitteen RESBP-anturi: Varmista, että käytössä on vähintään ohjelmistoversio 3.3228

	Hengitysliikkeisiin liittyviä tietoja ei näy
	RESBP-anturia ei ole yhdistetty WatchPAT™ 300- tai WP200U-laitteeseen
	Varmista, että RESBP on yhdistetty vain WP200U- tai WatchPAT™ 300-laitteeseen

	Oksimetrialukema ei kelpaa (oksimetria-arvo on 127 %)
	Signaali ei riitä anturin toimintahäiriön / liikkeen aikana tallennetun lukeman / heikon tai vaihtelevan signaalin voimakkuuden takia
	Jos oksimetrialukema on kelvoton parhaissakin olosuhteissa, vaihda uPAT-anturi. Jos lukema on edelleen kelvoton, vaihda uPAT-johto tai ota yhteys Itamar Medicalin tukeen.


	Varoitusviesti: 
Kuorsaus- ja kehon asentotietoja ei ehkä ole esitetty oikein tutkimuksessa.
Katso lisäohjeita käyttöoppaasta
	Vaihtoehto 1:
Jos digitaalista RESBP-anturia käytetään laitteella, joka ei tue digitaalista RESBP:tä, kuten WatchPAT™ 200U, anturi ei tallenna kelvollisia signaaleja ja näet varoitusviestin. 


Vaihtoehto 2:
Tutkimuksen aikana havaitaan hetkellisiä yhteyskatkoja rinta-anturin ja WatchPAT™-laitteen välillä
	Vaihtoehto 1:
Digitaalisen ja analogisen RESBP-anturin tunnistaminen (digitaalisessa RESBP:ssä ei ole valkoista väriä)

	Analoginen RESBP
	Digitaalinen RESBP
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Varmista, että digitaalista RESBP-anturia käytetään vain WatchPAT™ 300 -laitteiden kanssa.

Vaihtoehto 2:

· Varmista, että rinta-anturi on liitetty kunnolla WatchPAT™-laitteeseen. 
· Varmista, ettei rinta-anturin johdossa tai liittimessä ole mekaanisia vaurioita.
· Varmista, että kuorsaus-/kehon asentotaulukossa on tietoja.
· Varmista, että kehon asentotiedoissa ei ole useita NA-arvoja 10 ensimmäisen minuutin jälkeen.
· Varmista, että kuorsausarvot eivät ole korkeita suurimmassa osassa tutkimusta. 
Ota tarvittaessa yhteys Itamar Medicalin tukeen


[bookmark: _Toc396387172][bookmark: _Toc125363656]Taulukko 2 – Vianmääritys, zzzPAT
	Jaettu käyttötila zzzPAT-ohjelmistossa

	Ongelma
	Mahdollinen syy
	Ratkaisu

	Käyttäjä ei voi kirjautua zzzPAT-ohjelmistoon
	Jaetussa käyttötilassa käyttäjä on ehkä määritetty jaettuun tietokantaan mutta ei paikalliseen tai toisin päin.
	Määritä käyttäjä toiseen tietokantaan tai
poistu zzzPATista ja kirjaudu sisään toiseen zzzPAT-tietokantaan (paikalliseen tai jaettuun)

	Tallennettua tiedostoa ei löydy
	Tiedosto on tallennettu toiseen tietokantaan (joko paikalliseen tai jaettuun)
	· Varmista, kumpaan tietokantaan zzzPAT on yhdistetty (tietokantayhteys näkyy zzzPAT-ohjelmiston tilarivillä)
· Sulje zzzPAT
· Käynnistä zzzPAT ja muodosta yhteys toiseen tietokantaan
· Valitse File>Open (Tiedosto>Avaa) ja etsi haluttu tiedosto

	Jaettu tietokanta ei ole käytettävissä
	Verkkoyhteys on poikki
	· Varmista, että zzzPAT-asemasta on asianmukainen verkkoyhteys ja että siitä on pääsy verkkopalveluihin. Kysy tarvittaessa neuvoa järjestelmänvalvojalta

	Valittua tutkimusta ei voi avata
	Tutkimus on toisen zzzPAT-käyttäjän käytössä
	· Odota, kunnes toinen käyttäjä sulkee tutkimuksen, ja yritä uudestaan
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	Apuohjelmat

	Ongelma
	Mahdollinen syy
	Ratkaisu

	Uuden tutkimuksen valmistelu epäonnistui
	Laite irrotettiin USB-asemasta liian nopeasti.
	Älä poista laitetta, ennen kuin esiin tulee tutkimuksen tallentamisen onnistumisesta kertova valintaikkuna

	Vain WP200(U): Uusi tutkimus tai zzzPAT ei tunnista WP200(U)-laitetta
	Aseman nimi on poistettu
	Alusta asema nimellä WP200 

	Vain WatchPAT™ 300: Uusi tutkimus tai zzzPAT ei tunnista WatchPAT™ 300-laitetta
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	Database Tools (Tietokantatyökalut) -painike tietokannan ohjatun asennustoiminnon ikkunassa tai zzzPAT-ohjelmiston Tools (Työkalut) -kohdassa ei ole käytössä
	Käyttäjällä ei ole oikeuksia tämän apuohjelman käyttämiseen
	zzzPAT-järjestelmänvalvoja voi muokata käyttäjän laajennettuja käyttöoikeuksia

	User Administration (Käyttäjähallinta) -painike tietokannan ohjatun asennustoiminnon ikkunassa tai Tools>User Administration (Työkalut>Käyttäjähallinta) -kohdassa ei ole käytössä
	Käyttäjällä ei ole oikeuksia tämän apuohjelman käyttämiseen
	zzzPAT-järjestelmänvalvoja voi muokata käyttäjän laajennettuja käyttöoikeuksia 

	Tietokantatyökalut eivät avaudu
	zzzPAT tai uusi tutkimus on käynnissä
	Sulje zzzPAT tai uusi tutkimus ja avaa tietokantatyökalut

	Pääkäyttäjä on unohtanut salasanansa
	-
	Ota yhteyttä Itamar Medical -edustajaan
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Jos sinulla on kysyttävää tästä käyttöoikeussopimuksesta tai haluat ottaa Itamar Medical -yhtiöön yhteyttä muussa tarkoituksessa, voit kirjoittaa meille seuraavaan osoitteeseen. 

Yhdysvallat:
Itamar Medical Inc.
3290 Cumberland Club Drive, Suite 100
Atlanta, Georgia 30339, Yhdysvallat
Puh.: 1 888 748 2627

Muut maat:
Itamar Medical Ltd. 
9 Halamish Street, PO 3579
Caesarea 3088900, Israel
Puh.: +972 4 617 7000
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Itamar Medicalin valtuutettu sääntelyviranomaisen edustaja:

[image: cid:image008.jpg@01C99FE5.E9650A10]Arazy Group GmbH 

The Squaire 12, Am Flughafen,
60549 Frankfurt am Main, Saksa
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Liite C: NAF-kanavan (lämpöilmavirta-anturi) käyttöönotto
zzzPAT tukee NAF (Nasal Air Flow eli ilmavirtaus nenästä) -signaalia kanavanäkymässä, kun tutkimuksessa käytetään NAF-lisävarustetta.

NAF-kanavan käyttöönotto
1. Avaa/lataa tutkimus, jossa käytettiin NAF-lisävarustetta.
2. Valitse kohdasta View (Näytä) valinta Define Channels in Montage (Määritä kanavat montaasissa).
[image: ]
3. Vasemmanpuoleisessa luettelossa (All Channels [Kaikki kanavat]) näytetään vaihtoehdot NAF ja NAF Filtered (NAF, suodatetut) (NAF-kanava, jonka suodatin vähentää signaalin kohinaa).
Valitse NAF, napsauta Add (Lisää) ja valitse sitten OK.

[image: Graphical user interface, application, Word

Description automatically generated]
4. Valitse Setup (Määritykset) -kohdasta valinta User settings (Käyttäjäasetukset) ja avaa Manage Montage (Montaasin hallinta) -välilehti. Valitse Save as (Tallenna nimellä) ja nimeä uusi montaasi, johon on lisätty NAF-kanava. 
[image: ]
5. Uusi montaasi lisätään montaasiluetteloon, kun tallennus on valmis.
6. Valitse Set as Default (Aseta oletukseksi) ja sitten OK.
[image: ]
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